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Account Detail Overview 

The Account Detail window puts all your account-specific information in one 
convenient location. This window gives you six tabs with streaming, real-time data:  

• Order Status  

• Saved Orders  

• Alerts  

• Balances 

• Positions  

• Transactions   

 
Stock symbols and price and volume data shown here and in the software are for 
illustrative purposes only. Charles Schwab & Co., its parent or affiliates, and/or its 
employees and/or directors may have positions in securities referenced herein, and 
may, as principal or agent, buy from or sell to clients. 

 

The Account Detail window automatically opens when you log on to the software 
and closes when you log off. If you are not interested in viewing this information, 
this window can be minimized to increase available screen real estate. 

If you minimized this window and want to quickly open it:  

1.  Click on Tools in the Main menu.  

2.  Select Find Active Tool > Account Detail.  
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Account Detail Menu  

Right-click in the Account Detail window and select Show Menu Bar to access the 
following options. 

 

FILE 

Page Setup Enables you to customize the current page for printing. Read the 
Printing Windows topic in the Getting Started section for more 
information. 

Print Prints the current page of the Account Detail 

Export To save the data on a particular page into a text (.txt) file for 
use in Excel or other programs, click on the tab whose data you 
wish to export and select Export from the File menu 

 

VIEW 

Positions When selected, a new window will pop up that is populated with 
your account positions. This window is similar to the My Positions 
watch List, but with only four columns; Symbol, Price, Quantity, 
and Change.  

• The Symbol column displays the security symbols of the 
positions in your account.  

• The Price column displays the last trade or closing price of 
the security.  

• The Quantity column displays the quantity of shares held 
of each position.  

• The Change column displays the net change of the 
security from either yesterday's closing price or today's 
opening price. The default is Change from Close, but can 
be switched to Change from Open by going to the Account 
Detail window Settings > General.  

Within this window, there are three pull-down menu options:  

File: Allows you to either print or close the window.  

Settings: Allows you to change the following General Settings of 
the window:  

• Display the Change column in either Text or Graphical 
format. Text displays the numerical change from open or 
close. Graphical displays the Change column as a 
horizontal graph bar, with negative change displayed on 
the left in red, no change as a magenta dash on the 
middle dividing line, and a positive change on the right in 
green.  

• When Graphical Display format has been selected, you 
can change the Graph Settings fields. Unit Increment 
determines the point change that the vertical lines 
represent. Unit Width determines the number of pixels 
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between each vertical line.  

• When checked, the Auto Sorting checkbox will 
automatically sort the column based upon the column you 
have clicked on.  

• The Data option allows you to display the change column 
in either Point Gain or % Point Gain.  

Position: Allows you to place a closing trade for the selected 
security.  

Messages 

 

Check Messages for the status of your orders and their 
execution, as well as information about alerts and the market in 
general.  

! NOTE:  Because error messages are displayed in this window, 
it’s important to keep it open at all times. 

You can: 

- Scroll up or down to review all activity that has occurred during 
the current trading session.  

- Check the status of an order placed during your current logon 
session.  

- See why an order might have been rejected.  

- Get color-coded order status:  

• White - Current session settings and added Alert details.  

• Black - Market session opening and closing information.  

• Blue - Any messages related to orders.  

• Black with yellow highlight - When an alert is 
triggered.   

 

SETTINGS 

General Calculate Change from Open: Allows you to view your 
positions as either a change from open or change from close. The 
default setting for account positions is a change from the 
previous day’s close.  

Order Cancel Confirmation: If checked, the software will ask 
for confirmation before canceling an order. This setting is active 
only if you have turned off Order Verification in the Trading 
Window Settings > General > Orders tab. 

Fonts Use this option to change the Account Detail font settings. 

Colors Use this option to change the Account Detail colors.  

Sounds To activate the Sound Alert option you must have a sound card 
and speakers. The system will alert at the following instances: 
Log On, Log Off, Live order entered, Order filled, and Order 
Canceled. Click Browse to find .wav files to use. Windows 
comes with several .wav files, and you may also download audio 
files from the internet or other sources. This software does not 
come with any .wav files. 
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Conditional Orders that are triggered and eventually filled will 
sound both the Live order entered and Order filled Sound 
Alerts (if you have selected sounds for these actions), as well as 
any sound alerts included as part of the action of the conditional 
order.  

 

ALERTS  (Refer to the Alerts topic for more detailed information about Alerts) 

Load Allows you to load saved Alert (*.alr) files 

Save All As Allows you to save the alerts in your Alert tab to a file 

New Click to begin creating a new alert. See Adding an Alert 
for detailed instructions 

Edit Click on the alert you wish to edit and then click Edit. 
The Edit Alert window will open allowing you to make 
changes. Click OK when you are finished. 

Remove Selected Click on the alert you wish to remove and click Remove 
Selected. The alert will be removed from your Alerts 
tab. Removing an alert will delete it from the system. 

Remove All Removes all alerts in the Alerts tab and permanently 
deletes them. 

Activate/Deactivate 
Selected 

Alerts that you want readily available but not 
necessarily active (live) all the time can be set to 
Inactive when they are not in use. Click on an alert and 
select Activate Selected or Deactivate Selected 
depending on the status you want for that alert. 

Activate All Makes all alerts in the Alerts tab active so that they will 
fire if their conditions are met. 

Deactivate All Makes all alerts in the Alerts tab inactive so that none 
of them will fire regardless of whether the condition is 
met (until they are made Active again). 

Templates The Alert Templates feature allows you to create alert 
"shells" containing the variables that you use all the 
time. Once established these can be quickly completed 
to fit a specific situation and  activated from windows 
such as the Watch Lists, Charts, etc. See Applying Alert 
Templates for detailed information 

 

ORDER STATUS (only visible when Order Status tab is selected) 

Cancel Cancels a live order from the Account Detail. (Only appears if an 
order is currently Live.) 

Change Allows you to change the order you highlighted. Not all orders can 
be changed, see Changing or Canceling Orders for more 
information.  

Details Allows you to view full details of the order you have highlighted, 
including partial fills. 
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POSITIONS (only visible when Positions tab is selected) 

Close Allows you to place an order to close the position you 
highlighted. 

Adjust Cost Click on a Position in the Account Detail and select Adjust Cost 
to change the dollar amount paid or received for that position. 
That adjusted number will be used as a basis for calculating the 
average share cost for any additional purchases and sales.  

 

TRANSACTIONS (only visible when Transactions tab is selected) 

Update Allows you to view specific account transactions up to 90 days 
old. See Transactions for more information.  
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Messages Window 

MESSAGES 

By clicking View > Messages in the Account Detail menu, you can view streaming 
order status in the Messages window for the current day only. If you log off and 
back on multiple times during the day, all messages for the previous session(s) will 
display in gray. 

The Messages Window provides useful information about your software settings, 
order status information, alert messages, and market session information.  If you 
make any changes to your software settings, these changes will also be noted in 
the Messages Window. 

The streaming data displayed includes:   

• New Order Accepted 

• Orders Filled       

• Nothing Done / Out   

• Alerts & Conditional Order Events 

• Change Order 

• Cancel Accepted  

 
As the Messages Window provides you with real-time information not always 
available in other parts of the application, we recommend leaving your Messages 
Window open while logged on. 

 

 TIP:  Printing Data From the Messages Window 

A copy of your log files is maintained in the SSPro folder on your C: drive for 
each day you log in to the software. These files can printed in text format. 
Please note that Schwab retains the official copy of these logs. 

To print data directly from the Messages window before logging off, go to File 
> Print. 
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Order Status 

ORDER STATUS 

The Order Status tab in the Account Detail window displays all orders - both open 
and closed - placed via any Schwab channel, including Schwab.com , TeleBroker™ 
and Velocity. 

The Order Status tab displays: 

• Open orders, closed orders that have been filled, or canceled orders: 
You can sort on any column in the Order Status window by clicking on the 
column header you want as your sort key.  

• Contingent Orders: This applies to SmartEx trailing stop orders that are 
held up until the trailing stop price is met. Once the price is met the order 
status changes to Open and a market order is submitted for execution. 

 
Stock symbols and price and volume data shown here and in the software 
are for illustrative purposes only. Charles Schwab & Co., its parent or 
affiliates, and/or its employees and/or directors may have positions in 
securities referenced herein, and may, as principal or agent, buy from or sell 
to clients. 

• Partial fills: The Quantity Filled At column displays information for the 
first fill. If there are additional fills, this column displays the average price 
with the number of shares. To view the individual fills, double-click on the 
order and an Order Details window will open displaying the fill events at the 
bottom. 

• Sorting by Column: Click on a column name to sort by that column (click 
again to reverse the sort order). Press Shift and click on a second column to 
perform a secondary, more detailed sort within the primary sort. For 
instance, if you wanted to see all the Open Buy orders, you could do a 
primary sort on Status and a secondary sort on Action and the Open Buy 
orders would be grouped together. 

Order Status automatically updates when orders are executed either via 
StreetSmart Pro or other Schwab channels.  
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! NOTE:  Short Sell-Exempt orders will display in your Order Status tab. A 
customer service representative may enter Short Sell-Exempt orders on your behalf 
in certain limited circumstances.  The most common instance when this may occur 
is when liquidating the underlying security where the position is held as either an 
equity right, warrant, or convertible. In these circumstances, the securities are not 
in an acceptable form for delivery on settlement date. Note that you must file an 
exercise for the right, warrant or convertible before your order to liquidate the 
underlying security can be marked as Short Sell-Exempt. This action acknowledges 
that the intent is to sell a position instead of short a stock and is therefore exempt 
from the up-tick rule.  Please see Up-Tick rule for more information. 

 

VIEWING ORDER DETAILS 

You can see additional details about your order not displayed in the Order Status 
tab - like detail for individual fills- in the Order Detail pop-up window.  
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Stock symbols and price and volume data shown here and in the software are for 
illustrative purposes only. Charles Schwab & Co., its parent or affiliates, and/or its 
employees and/or directors may have positions in securities referenced herein, and 
may, as principal or agent, buy from or sell to clients. 

To Open the Order Detail Window: 

There are three ways to access the details of your orders: 

• Highlight the order and double-click on it.  

• Highlight the order, right-click on it, then select Details.  

• Highlight the order and select Details from the Orders drop-down menu 

 

CHANGING OR CANCELING ORDERS 

Changing Orders 

To change a SmartEx order, go to the Account Detail window, Order Status tab and 
either right-click on the open order then select Change or click once on the order 
to highlight it, then click Orders > Change. A pop-up box will appear prompting 
you to modify your order.  

Note that you cannot change the order type of a SmartEx order to or from a trailing 
stop order after the order has been submitted. You must first cancel the order and 
then resubmit with a different order type.   
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Direct Access orders can never be changed.  

Canceling Orders 

You can request to cancel open orders via the Order Status Tab. All Open orders 
have a green box in the left-most column. Because of the speed of execution and 
the short life span of market and marketable limit orders, canceling these orders 
may not always be possible.  
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Saved Orders 

SAVED ORDERS TAB 

Saved orders, made by clicking the Save button when entering a SmartEx order in 
the Trading window, are listed under this tab.  

 

 

To Submit an Order From the Saved Orders Tab:  

1. Right-click on the order you want to send.  

2. The order will highlight.  

3. Choose Submit to send the order.   

You can also use the Saved Orders drop-down menu to access the Submit, Edit or 
Delete functions.  

 

Tab Columns Descriptions 

Symbol Displays the unique characters used to represent the security. 

Action  Displays the action type of the order (Buy, Sell, Buy to Open, 
etc.). 

Quantity Shows the number of shares or contracts to be traded. 

Price Shows the price at which you want the order placed. 

TIF Displays the Time In Force: Day, GTC (Good ‘Til Cancelled), 
etc.  

Date & Time Shows the date and time the transaction was saved. 

Type Displays the type of security, such as an equity or option 
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Right-click 
Options 

Descriptions 

Load 
[Symbol] 
into Trading 
Window  

• Loads the symbol into the Trading window.  

• The quantity field is set to the Trading window default 
size – this default may be changed or you may set the 
default to match your position size. Go to the Trading 
window and select Settings > General > Orders tab to 
change the default quantity.  

Recent 
Stories for 
[Symbol] 
Stock  

Loads the symbol into the Recent Stories tab of the News 
window.  

Research/Ext 
Quote for 
[Symbol]  

Launches a web browser that automatically opens the 
Schwab.com Quotes and Research tab and provides 
information for your symbol. 

Apply Alert 
to [symbol]  

Opens sub-menu allowing you to use an alert template or 
create a new alert. 

Submit  • If the Order Verification preference is selected, clicking 
here will open the Verification window before submitting 
the order. 

• If the Order Verification preference has been disabled, 
the order will be automatically validated and sent to 
Schwab for execution. If there are errors, you will receive 
an error notice in the Messages window. After editing you 
order, you can resubmit it in the Order Entry panel of the 
Trading window.  

Edit  Opens the Edit Saved SmartEx Order pop-up window.  

Delete Removes the saved order from the window.  

Show/Hide 
Menu 

Shows/removes the Account Detail menu.  
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Alerts 

ALERTS OVERVIEW 

Alerts and Conditional Orders are designed to help you protect profits 
and limit your loss potential by monitoring for the market conditions 
you specify – even when you’re not online.  

When logged in, you can have the software alert you when certain price 
conditions you specify are met. Even if you are not logged in, you can 
have orders placed automatically on your behalf when your Alert 
conditions are met.  

Set up alerts using the Alerts menu displayed in the Account Detail window 
when the Alerts tab is selected. 

Overview 

StreetSmart Pro® software offers a variety of ways to keep you informed of specific 
quote and volume changes for specific equities, options, and indices that you 
select. Alerts range in degrees of complexity from basic to advanced. Examples of 
each Alert type and how they function are included in this section of the manual. 

Basic Alerts:  

Basic alerts use a single "absolute" criterion to set off (trigger) the alert. Once the 
alert condition is met, no additional calculations are required before the alert is 
fired. There are two absolute criteria:  

• Increases to  

• Decreases to  

Intermediate Alerts:  

Intermediate alerts use a single "variable" criterion to trigger the alert. The variable 
criterion is based upon a change from a value that is determined at the time that 
the alert is created. If you create an alert to fire when the Bid for a particular 
security gains 1 point, the software will reference the current inside Bid at the 
moment that the alert was created. There are two variable criteria:  

• Gains  

• Loses  

Advanced Alerts:  

Profit and Loss alerts (Share P&L and Trade P&L) are advanced alerts that are 
always based upon two separate calculations involving the criteria that you select. 
The sequence of calculations in a P&L alert is as follows:  

• First, your current P&L is calculated. Trade P&L and Share P&L are 
calculated differently although the end result is much the same. Your choice 
depends on which you feel more comfortable using. When using Trade P&L 
as a variable, you will need to input the cost of the trade vs. the per share 
price. When using the Share P&L variable you will need to input the price 
paid per share.  
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The application takes the Original Trade or Share Price that you enter and 
compares it to the current Bid or Ask at the moment the alert was created to 
determine your unrealized profit or loss. The Bid is used if you are long the 
security and the Ask is used if you are short the security.  

• Second, a calculation is made based upon the criteria you select. Note that 
when using the gains or loses criteria, the system is using the current P&L 
amount or percent as a basis. If you are 10% profit already and you input 
‘gains 5%’ the alert will trigger when your profit reaches 10.5% because a 
5% gain on 10% is .5%.    

You can also set up alerts and conditional order commands for using different 
symbols for the condition and the conditional order. Useful combinations include an 
index coupled with an individual stock or an order for an option using its underlying 
equity for the condition.  

Change from Open and Change from Close alerts can be more complex when using 
the Gains % and Loses % criteria. See 'Change From Open' Alerts and 'Change 
From Close' Alerts topics for more specific examples.  

Persistent Alerts 

StreetSmart Pro® Alerts support server-held alerts and conditional orders to better 
customize your platform to your risk management needs. There are three ways to 
manage the time-frame of an alert: 

 

Persistent/GTC (Good ‘Til Cancel) Alerts: 

This type of alert remains active, unless triggered, for 60 days regardless of your 
logon status. To make your alert persistent/GTC, check Keep alert active after 
logoff when setting up the alert. This alert can be set up at any time, but will be 
active only during the standard session. 

Persistent/Day Alerts: 

Regardless of your logon status, these alerts will remain active, unless triggered, 
during the current standard session and will automatically deactivate at market 
close (4:00 p.m. ET). To make your alert persistent/Day, check Keep alert active 
after logoff AND Day Alert when setting up your alert. Day Alerts can be set up 
any time but must be manually activated by you on the day you wish to use them. 
This alert type can be activated anytime beginning at midnight ET and throughout 
the trading day until market close.  

Logon Session Only:  

This type of alert (initiated by not checking Keep alert active after logoff) 
remains active only while logged on to the system. If you lose your connection to 
the StreetSmart Pro servers, any open alerts will remain on the system for 10 
minutes. This allows you to log back in without losing the alerts. You must 
reestablish your connection within 10 minutes to ensure that any outstanding alerts 
are not lost. If you do not log off or get disconnected and your alert has not 
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triggered, it will be deactivated at the end of the current standard session (4:00 
p.m. ET).  

 

BASIC GUIDELINES ABOUT ALERTS 

• You can activate alerts outside of standard market hours, but because alerts 
require updated Level 1 quote information to function, they will not be 
initialized or become live (actionable) until the market opens. You can set up 
new alerts or alerts created from templates at any time and they will display 
in the Alerts tab.  

o Persistent alerts that are good for 60 days will automatically initialize 
at the next market open.  

o Day Persistent alerts must be manually activated on the day of their 
use but you do not need to wait until market open to do this.  

o Alerts that are good for the current logon session only do not 
initialize until the open of the standard session (9:30 a.m. ET).  

o At the end of the standard market session, all open Day alerts are 
deactivated.  

o Persistent alerts that are good for 60 days will remain active but will 
not be acted upon until the next standard session.  

o All alerts will remain in the Alerts tab pending further action such as 
editing, activation, deactivation or removal.  

• You can only use P&L alerts for securities in which you hold a position.  

• Alerts with Conditional Orders for Boxed Positions can only be routed via 
SmartEx.  

• Alerts established with conditions that have already been met will instantly 
fire when the alert is set.  

• If you lose your connection to StreetSmart Pro® servers, any open alerts 
where Keep alert active after logoff is not checked will remain on the 
system for 10 minutes. This allows you to log back in without losing the 
alerts. You must reestablish your connection within 10 minutes to ensure 
that any outstanding alerts are not lost. When you log back on, please check 
the alert tab to make sure that all your alerts are still open and your 
messages and order status in the event that your conditions were met and a 
conditional order was sent.  

• You can enter either positive or negative values with the Increase to and 
Decrease to criteria, depending upon your goal.   

• The Trailing Stop feature is only available with Gains and Loses alerts.  

• The Trailing Stop feature should not be confused with the Stop Order (order 
type). All alerts with Trailing Stops will be entered as a Market or Limit order 
types.  

• Alerts with conditional orders can execute trades based on bad or out of 
range time and sales prints. You will be responsible for any orders that are 
executed, even if they are based upon inaccurate information. To minimize 
possible issues, the Bid or Ask variable should be considered when sending 
conditional orders for NASDAQ stocks and the (last) Trade Price variable 
should be considered when sending conditional orders for Listed securities.  
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NOTE: This is not a guarantee that orders will not be sent based on ‘bad 
prints’ and will not completely remove the risk of alerts firing based on 
inaccurate data. 

• P&L Alerts are triggered off of the Bid price if you are long the security or Ask 
price if you are short the security.  

• Alerts for indices should only be set up using the variables Trade Price, 
Change from Open, and Change from Close. Although you can create 
alerts for indices using other variables such as Bid or Ask, these alerts will 
never fire because the variables do not exist for indices.  

• Avoid placing alerts on any stock that does not have bid/ask quotes. Such 
alerts will not fire.  

• Positions with Fractional Shares: If an alert to sell a position will leave 
only a fractional share in the account (less than one full share), the alert will 
fire but the order will be rejected and not executed.  If you are placing a sell 
alert for a position that has fractional shares and desire to sell the full 
position, please use the “close” feature located under the 'Action' drop down 
and select 'All' under the 'Quantity' drop down in the Order Entry area of the 
Alert template. 

Critical Alert Information 
• Logging off, exiting the system, or being timed out from your session will 

deactivate any alerts that do not have Keep alert active after logoff checked. 
Saved alert files and Templates are still inactive, but can be easily loaded 
when you logon again.  

• You may choose to confirm orders before sending. You must be logged on to 
your software for a triggered alert to send an order if confirmation is 
required.  

 
If you do not have this setting checked, your active alert will trigger an order 
without your confirmation whether you are logged in or not. 

• If you have alerts set without Keep alert active after logoff checked and 
you lose your Internet connection due to system failures, like a computer 
crash or network disconnection, those alerts will be held on the server for 10 
minutes only. If you do not log on again in 10 minutes, the alerts are 
automatically removed from the system. If your alert is triggered during that 
10 minutes and you are still not logged on, the alert will not trigger or send 
the order. 

• Alerts established with conditions that have already been met will fire 
immediately after the alert is set. 

• When placing a Conditional order where you specify a certain number of 
shares to trade, if the tradable quantity of your position is less than the 
specified number, the software will send the order for the lesser amount 
instead of not sending the order due to insufficient shares available to trade. 
 
EXAMPLE You have 700 shares of AAPL with a trailing stop active that will 
close 1000 shares if the bid loses .05 points. When the bid drops .05, a 
SmartEx market order for 700 shares will be sent, as opposed to the 
software trying to send 1000 shares and rejecting the order because you 
don't have sufficient shares to cover the trade. The same will hold true if you 
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are short 1000 shares of AAPL and you try to buy 1500 shares using a 
conditional order. 

• After an alert has triggered, it will automatically be deactivated. The same 
alert cannot trigger more than once without being reactivated first.  

• Alerts with conditional orders to close (sell if long or buy if short) will not fire 
if you do not hold the underlying security; however, if you hold a position, 
liquidate it, and then re-enter the position, the alert established for the 
original position will apply to any new positions. For example, if you hold 
ABCD and have an Alert with a conditional order to sell ABCD that is based 
on a prior entry point, once the Alert conditions have been met, the Alert will 
fire and the order will be sent. While there are mechanisms in place to try to 
prevent an oversell, if you manually exit a position you should ensure that 
you do not have open Alerts with conditional orders to sell that position. 

• Alerts, Stop Losses and Conditional orders that have not fired will 
automatically be cancelled at the end of the standard session (4:00pm ET) if: 
- you check Keep alert active after logoff AND Day Alert when setting up 
the alert, or 
- if neither is checked and you do not log off before the end of the standard 
session. 

• If just Keep alert active after logoff is checked, but not Day Alert, the 
alert can stay active for up to 60 days. 

• It is important to review your conditional orders carefully. If you do not 
select Confirm order before sending, which allows you to review your 
order at the time your alert conditions are met, you will not have an 
opportunity to review or verify your Stop Loss or Conditional order once the 
Alert you have set is triggered. You may change or cancel this order while in 
its conditional state (prior to the alert being triggered). This can be done by 
going to the Alerts tab of your Account Detail window, selecting the alert and 
then selecting Edit from either the Alerts drop-down or right click menus. For 
more details, see Edit or Delete Alerts on the next page. Note that once the 
order is submitted it becomes a live order.  If your conditional order is a 
market order it will probably fill before you would have a chance to cancel or 
change it. If you specified that the conditional order be sent as a limit order, 
it can be changed or cancelled just like any other Open order. 

 
After completing the Alert window and specifying a Conditional Order, you will 
receive a verification of your order to review (unless you have disabled this 
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function). After reviewing your order and you click OK, the following window 
will appear: 

 
(2007-5984) 

USING ALERTS 

Alerts can be set up directly through the Alerts tab in the Account Detail window. If 
you typically use the same criteria for all your trades, you can also use one of the 
standard templates or create your own Alert Template.  

Alerts displayed in the Alerts tab can be in one of two states: Active or Inactive. 
Alerts in active status will fire when the conditions are met. Once an alert fires it 
will automatically become Inactive. You can reactivate or deactivate an alert at any 
time during your session.  

Retrieve a Saved Alert 

You can access previously saved alerts by:  

1. With the Alerts tab selected in the Account Detail window, click Alerts > 
Load from the menu.  

2. Click on the previously saved alert file and select from the following:  

• Yes: Adds the alerts to your existing alerts  

• No: Replaces the contents of the Alerts tab with the alerts in the 
selected file  

• Cancel: Makes no changes and allows you to exit the process 

3. The alerts appear in the Alert tab and will be inactive.  

Save All Alerts to a File  

You can add all of your alerts to one file by clicking Save All As in the Alerts tab.  

To retrieve these alerts at a future time select Load..., a window will appear 
containing all of your alert files. Select the file you wish to load. All of the alerts 
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contained in the file will then be displayed in the Alert tab in an Inactive status. You 
can then choose to activate each alert manually or Activate All at once. Either way 
you choose you should review the details of each alert to ensure that you want to 
activate each as it is currently set-up.  

Save a Single Alert to a File 

Select the alert you wish to save by clicking on it. Either right-click or click Alerts 
> Edit in the menu. From this window click Save As at the bottom. You will then 
be able to create a new file for the alert or add it to the existing file by selecting the 
Append to file checkbox.  

Add an Alert   

When a standard template doesn't meet your needs, you can use this feature to 
create your own alert:   

1. Click Alerts > New.   

2. Complete the fields in the Condition panel. For more information on how to 
complete this window, go to Alert Settings.  
- To add more than one condition, click the and or or radio buttons. 
- Note that changes expressed as a percent must be used in conjunction 
with the gains or loses variable.  

3. Then specify the actions the alert should take in the Action panel.  

4. Click OK to add the alert to the Alerts tab.   

5. When added to the tab during the standard session the alert is activated, 
and a confirmation will appear in the Messages window.   

6. To save your alert(s) in a file, follow the process outlined in the previous 
sections.   

Edit or Remove an Open Alert   

You can edit or delete an open alert by:   

1. Click on the Alerts tab.   

2. Click on the alert you want to edit or delete to highlight it. 

3. From either the Alerts or the right-click menu select Edit to make changes 
or Remove to delete the alert from the tab. NOTE: You can also double-
click on the Alert to open the Edit window.   

4. If editing, click OK to review your changes and activate the settings.   

5. When the alert is either deleted or edited, a confirmation will appear in the 
Messages window.   

6. To save your settings in a file, go to the Alerts or the right-click menu and 
select Save All As or Edit if saving a single alert. In the Save Alert window, 
you can name it as a new file or add it to an existing file by selecting the 
Append to file checkbox.   

Remove an Alert   

1. Click on the alert you wish to delete.   

2. In the Alerts menu select Remove Selected.   

3. The alert will be permanently deleted.   
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Remove All Alerts   

Used when you wish to permanently delete all alerts in the tab.   

• In the Alerts menu select Remove All.   

Activate an Alert   

When an alert fires it will be automatically placed in inactive status. When an alert 
is not active it will remain in the Alerts tab but will be dormant. Alerts can be 
activated using the Activate Selected or Activate All menu items. There is no limit 
on how many times an alert can be made active.   

Activate Selected   

1. Click on the alert that you wish to activate. NOTE: The alert must be in 
inactive status or this menu selection will be grayed out.   

2. In the Alerts menu select Activate Selected.   

3. When the alert is activated you will be presented with the order verification 
and Alert warning windows. You will also receive confirmation of this action 
in the Messages window.   

Activate All   

1. In the Alerts menu select Activate All.   

2. When the alerts are activated you will be presented with a series of order 
verification and Alert warning windows. Once you have clicked through these 
windows you will receive confirmation of these actions in the Messages 
window.   

Activation at Market Open 

At market open, a window will pop up asking you whether you want to activate 
your inactive alerts. 

If you activate your alerts at this time, all inactive alerts regardless of their prior 
history (whether triggered by the software or deactivated manually) will become 
active. 

Deactivate All   

1. In the Alerts menu select Deactivate All.   

2. All of the alerts previously in Active status will be changed to inactive status. 
In this state they will be dormant until you choose to reactivate them. You 
will also receive confirmation of this action in the Messages window.   

Templates   

Alert templates allow you to quickly set-up alerts. You can select from the sample 
templates included with the software or choose to edit these, or create custom 
templates that satisfy your specific needs. For more information about this feature 
please go to the Templates topic.   

1. In the Alerts menu, select Templates.   

2. The Templates window will open allowing you to select from the available 
alert templates.  
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 TIP:  You can either edit an existing template or create your own from scratch. 
While you can create templates by completing any of the available fields, the most 
useful templates typically have the symbol and the value fields blank so you can 
apply your strategy to any symbol and adjust the trigger points as appropriate.  

! NOTE:  Once created, alerts can be activated and deactivate repeatedly during 
the logon session.  

 

ALERTS & RISK MANAGEMENT 

StreetSmart Pro® provides Alerts with the option to trigger an order when the alert 
criteria you set are met. Conditional orders can be incorporated to accommodate 
specific investment strategies and manage risk.   

 

 
 

StreetSmart Pro can help you achieve risk management using Alerts with 
Conditional orders or by placing Stop or Stop Limit orders. Below are examples of 
how risk can be managed once a position is established.  

Place a Stop or Stop Limit order  

• You determine the exit point at which you want to limit your losses.   

• Select the position for which you wish to place a stop loss order in your 
Account Detail Positions tab and select Close option from the right-click or 
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drop-down menu. Select the Stop or Stop Limit Order Type and complete 
the screen. 

• Submitting this order will close the position once the price point has been 
reached.  

• ! NOTE:  Not all securities are eligible for Stop or Stop Limit Order Types.  

Alert with a Conditional Order  

• An alternative to submitting a Stop or Stop Limit order is setting up an Alert 
with a Conditional Order. Using this type of Alert will also allow you not to 
show your order to the marketplace until your risk threshold has been 
reached. It also allows you to set both a Profit exit and a Loss exit that would 
trigger an order to close your position if either are reached. 

• To create a loss exit, if you are long a position, create a condition using Bid 
decreases to as the criterion. You may also choose to use a Bid loses _ 
Points or _% providing more flexibility than what is available using a Stop 
order.  If you are short a position, you can do them same using an Ask 
variable. 

• To create a profit exit, if you are long a position, create a condition using the 
Ask increases to as the criterion. You may also choose to use Ask 
increases __ Points or __% providing more flexibility than is available 
using a Stop order. If you are short a position, you can do the same thing 
using the Bid variable. 

• Be sure to select the Or radio button at the top of the second condition if you 
are including both a loss exit and profit exit in you conditional order. 

• NOTE: While you can use this type of Alert to help with risk management, it 
is only similar to a Stop order if you select Enter Order as one of the 
Actions.  If you choose not to Enter Order, the Alert will still let you know 
when your risk management threshold has been reached, but you would 
have to enter a new order from the Trading window to minimize your risk 
exposure.  

Alert With Conditional Order using Trailing Stop  
• The functionality is very similar to the Alert with a Conditional order.  The 

difference is that you now have a variable trigger (Trailing Stop) which will 
become effective only after the price of the security has had an up tick. 

• ! NOTE:  If no up tick occurs when using a Trailing Stop, the Conditional 
order acts like a Stop order, as there is no price increase to 'Trail' back from.  

• To add a Trailing Stop to your Alert, check the Trailing Stop box.  This box 
only becomes available when the criterion is either gains or loses.  

• EXAMPLE You are long 1000 XYZ, which was purchased at $20 per share. If 
you have a risk threshold of 10%, you would want to get out of the position 
if the bid for XYZ decreases to $18 per share at the time you purchased it, or 
10% less than highest price reached after that.   
 
You enter a Trailing Stop Alert at $20 to fire when the Bid loses 10%. 
 Assuming the stock price then increases to $25 per share, the Trailing Stop 
will trigger if the Bid then decreases to $22.50 per share. $25 x 10% = 
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$2.50 per share. $25 - $2.50 = $22.50 per share. 
 
If the stock never moves above $20 per share and you set up the same type 
of Alert, it will only fire if the Bid loses 10% ($18). $20 x 10% = $2. per 
share. $20 - $2 = $18.  

• You may also enter Trailing Stop orders from the Trading window by sending 
a SmartEx Trailing Stop order type. This will display the conditional order in 
the Order Status tab until the trailing stop condition is met and the order is 
sent and becomes an Open order. Alerts with Conditional Orders using a 
Trailing Stop will display in the Alerts tab. Use either method of setting a 
trailing stop depending on your needs and preferences. 

! NOTE:  When placing a Conditional order where the order action is Close and 
where you specify a certain number of shares to trade, if the tradable quantity of 
your position is less than the specified number, the software will send the order for 
the lesser amount instead of not sending the order due to insufficient shares 
available to trade. 

EXAMPLE  You have 700 shares of AAPL with a trailing stop active that will close 
1000 shares if the bid loses .05 points. When the bid drops .05, a SmartEx market 
order for 700 shares will be sent, as opposed to the software trying to send 1000 
shares and erroring out because you do not have sufficient shares to cover the 
trade. 

 

ALERT SETTINGS 

The Alerts window and the Alert Templates window have the same settings. 
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Alert 
Settings 
Window 
Fields 

Description 

Conditions 
Panel 

Sets up the conditions that will trigger your Alert or Alert with 
Conditional order. 

Symbol  Enter the symbol of the stock or option, or click the down arrow 
at the right of the box to choose from the current positions you 
hold.  

This symbol can be different than the symbol in the conditional 
order command. 

For options, you may enter the symbol as ".symbol" or 
"symbol.o". 

Option 
Check Box 

• Automatically checked if you select an option symbol from 
the pull-down Symbol box.  

• You can manually check this box if you are creating an alert 
and/or a conditional order for an option, but it is not 
required if using entering an options symbol. 

Original 
Trade Price 

• Enter the original purchase price you paid for the equity or 
option here.   
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• Only available for Share and Trade P&L alerts.  

• If the variable is Share P&L, enter the average share price 
you paid for the position. 

• It the variable is Trade P&L, enter the total dollar amount 
you paid for the position. 

Keep alert 
active after 
logoff 

• If checked and you log off the software, the alert will be 
saved to the server and still will be active the next time you 
log on. Note that the alert may still fire if the alert is active 
even though you are logged off; however, if you have 
elected to confirm the order before sending, these alerts 
may trigger but will not send a conditional order if you are 
logged off.  

• If checked, but Day Alert is not checked, this alert can stay 
active for up to 60 days.  

Day Alert This box is available only when Keep alert active after logoff 
is checked. A Day Persistent alert is good for the current day 
only but will remain active regardless of whether you are logged 
on or not. When checked, an Active Day Alert will automatically 
deactivate and cancel the order at the end of that day’s 
standard session (4:00 p.m. ET).  

Save as 
Default 

When checked, this alert will save drop-down menu positions 
and checkbox settings, but will not save settings in the Value 
field or the order entry fields.  

Conditions 
Panel 

Sets up the conditions that will trigger your Alert or Alert with 
Conditional order. 
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Variable The variable determines which data will trigger your order. 
Share P&L, Trade P&L, Change From Open and Change 
From Close are all change/delta variables, that is, they are the 
result of a calculation.  

• The P&L variables are the difference between the cost 
and the current price.  

• The Change From Open or Change From Close are the 
difference between the price of the security at the open 
or the close and the current price.   

Share P&L  

When you set a Share P&L alert, this P&L amount is based on 
the difference between your Original Trade Price and the 
current bid price if you are long the stock or the ask price if you 
are short.  

For example, if you purchased 100 shares of DELL at 30 and it's 
currently trading at 33, your share P&L in this case is 3 points 
or 10%.  If you want to exit your position with a 6 point profit 
or 20% gain, the Share P&L would need to gain 100%. 
Alternatively, you could designate the Share P&L to Increase to 
6 points. 

! NOTE: Share P&L initializes each day based on the Market 
Open Price, rather than on your original trade price. This means 
that if you are using a Variable of Share P&L and a Criteria of 
Gains or Loses and the stock opens significantly higher or lower 
than the price at which you purchased the stock, the 
initialization value could be applied further from the original 
trade price than you might wish. 

Trade P&L  

When you set the alert, this P&L amount is based on the 
difference between your Original Trade Price and the current bid 
price times the number of shares you own if you are long on 
the stock or the ask price if you are short.  

Referencing the example in Share P&L above, your Trade P&L 
would be $300.00. If you want to exit your position with a 
$600.00 profit or 20% gain, the Trade P&L would need to gain 
100%.  Alternatively you could designate the Trade P&L to 
Increase to $600.00. 

Bid   

Bases your alert on the inside Bid price.  

Ask   

Bases your alert on the inside Ask price.  

Volume   
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Bases your alert on the daily cumulative volume.  

Trade Price  

Bases your alert on the last sale price reported.  

CAUTION:  It is not uncommon for erroneous trade reports to 
come through the Time & Sales display with prices away from 
of the market. If an "erroneous price" triggers your order, it is 
your responsibility and a subsequent execution cannot be 
reversed. Exercise caution when basing Conditional orders on 
Trade Price. Alternatively the current Bid or Ask can be used to 
achieve result that closely matches the Trade Price variable. 

Change from Open   

You can set up an alert to trigger based on the difference 
between the current price of a stock and the price at the open.  

Note that the change amount itself is used as a basis for the 
calculation, so that if the current Change from Open is .10 and 
you want an alert to trigger when the Change from Open is .30, 
we would need to set an alert that triggers when it Gains .20 
points or 200% or Increases to .30.  

Change from Close   

You can set up an alert to trigger based on the difference 
between the current price of a stock and the previous closing 
price.  

Note that the change amount itself is used as a basis for the 
calculation so that if the Change from Close is 10 cents, for 
example, and you want an alert to trigger when the Change 
from Close is 30 cents, it would need to gain .20 points or 
200%.  Likewise, the Change from Open could increase to 30 
cents. 

Criteria There are four criteria available:  

• Increases to/above  

• Decreases to/below  

• Gains  

• Loses  
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Value The amount you want the criteria to change by.   

For Gains and Loses criteria, if a negative value is entered, the 
value will revert to 0.  

! NOTE:  Choose Loses in the criteria window and enter a 
positive value rather than trying to trigger an alert based on 
negative gains. Increases To and Decreases To criteria will 
accept either a positive or negative value depending on your 
goal.   

Points, $, 
% or 
Shares 

Work in conjunction with the Variable and Criteria.  

The Variable and Criteria you choose will change your available 
options for these fields. Note that if you wish to set a 
percentage value or set up a Trailing Stop you must use the 
Gains or Loses criteria. 

Trailing 
Stop 

Works only with the Gains and Loses criteria, and can be 
applied to a point value or a percentage. It’s important to note 
the difference between a Trailing Stop Alert and a Stop or Stop 
Limit order. See Alerts & Risk Management topic for more 
information  

Trailing Stop Alert example:  

You are long 1000 XYZ, which was purchased at $20 per share. 
If you have a risk threshold of 10%, you would want to get out 
of the position if the bid for XYZ decreases to $18 per share at 
the time you purchased it, or 10% less than highest price 
reached after that.   
 
You enter a Trailing Stop Alert at $20 to fire when the Bid loses 
10%.  Assuming the stock price then increases to $25 per 
share, the Trailing Stop will trigger if the Bid then decreases to 
$22.50 per share. $25 x 10% = $2.50 per share. $25 - $2.50 = 
$22.50 per share. 
 
If the stock never moves above $20 per share and you set up 
the same type of Alert, it will only fire if the Bid loses 10% 
($18). $20 x 10% = $2. per share. $20 - $2 = $18. 

And/Or Allows you to add an additional condition to your Alert.  

• When you select And, both conditions must be met at 
the same time for the alert to trigger.   

• When you select Or, either condition can trigger the Alert 
independent from the other.  
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Action 
Panel Beep  

If the system reaches all preset criteria, the machine will beep 
once.  

Pop-Up Messages Window   

The Messages window will display a notification if the Alert is 
triggered.  If the Messages Window is not currently viewable, it 
will pop-up displaying your triggered Alert notification. 

! NOTE:  Whether or not you select this option, a notification is 
always displayed in the Messages window.  

Load Trading Window  

Choose to have the stock or option load into the Trading 
Window as soon as the Alert is triggered.  

Play Sound File   

The system can be set to play an audio file when an Alert is 
triggered, if you have a sound card and speakers.  

The software has two sound (.wav) files included with the 
application. Additional sound files can be downloaded from the 
Web and are also included in the Microsoft Windows operating 
system software. To add a new sound file to your pull-down 
options: 

1. Check the Play Sound File box. 

2. Click Add. Select the folder where your .wav files are 
saved. 

3. Select the file you want to add, then click Open. 

4. To hear the sound file, click the 'play arrow' to the right 
of the pull-down box. 

5. You may remove any added sound file by selecting it in 
the pull-down box and click Remove. 

Enter Order  

Check this option if you want the system to send out an order 
once all criteria are met. Be sure that the following four fields 
are completed first: Order Type, Shares, Price and Method. 
 These are known as Conditional orders. 

! NOTE:  Unless you check the Confirm order before 
sending checkbox, you will not receive an Order Verification 
message when the Conditional Order is triggered. Be sure you 
carefully review the terms of the Conditional Order before 
submitting it.   

Symbol The condition symbol will automatically populate but can be 
changed.  
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Order Type  • Choose from Buy, Sell, Short and Close.   

• Close will either submit a Buy or Sell depending on 
whether you are long or short. If you input a share quantity 
and your tradable position is less than this amount when 
the alert fires, the software will send the order for that 
lesser net tradable amount.  

• If you checked the Options box, you can choose from:  
Buy to Open, Buy to Close, Sell to Open, Sell to Close 
or Close.  

Shares Enter the quantity you want to submit in this box. If you are 
using Close as the order type, you can use All in this field or 
manually input a quantity. 

Price You can either select Market from the pull-down box or enter a 
limit price. 

Note that since conditional orders are not submitted until the 
conditions that you specified are met, a Market order will 
ensure fills at the current price of the security at the time the 
order is received by the market. 

Method Conditional orders will be sent via SmartEx or via select Direct 
Access routes (for those qualified for Direct Access trading).  

Confirm 
Order 
Before 
Sending  

Choose to have an order verification window pop-up when the 
order conditions are met and the order is sent.  

Note that if you are not logged onto the system to confirm your 
order at the time the order is triggered, it will not be sent. 

Command 
Description 
Panel  

Displays a full description of the Alert you have set up.  

! NOTE:  • When conditional orders are set up, an Order Verification 
window will be displayed if you have Order Verification 
enabled.   

• Click OK to prepare the Alert and Conditional order for 
activation or click Save to save your alert to a file. To load 
your alerts at a later time select Load in the Alerts menu 
and then select your saved file.   

 

ALERT TEMPLATES 

StreetSmart Pro® provides you with: 

• Sample standard templates for commonly used trading strategies. They can 
be customized or deleted.  

• An Alert Templates feature that allows you to add your own templates with 
specific pre-set Alert, Trailing Stop or other Conditional order criteria.  

• Standard or customized template that can be activated by right-clicking on 
any open position from the Account Detail window and selecting the 
Template name. 
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With StreetSmart Pro, you can use the following Alert Templates or create your 
own: 

 

Straddle • Can help protect you against large swings in the market by 
alerting you to both increases and decreases in a security's 
Bid price.   

• This Alert includes the Conditional order action.  

Trailing 
Stop  

• Allows you to follow the price movement upward and only 
trigger the Alert when the Bid decreases by the amount 
specified.   

• This Alert includes the Conditional order action.  

Stop Loss • Alerts you when the Bid decreases to a specified Value.  

• This Alert includes the Conditional order action.  

Ask 
Increases 

• Alerts you when the Ask increases to a specified Value. 

Buy In • Alert you when the Ask of a specific security increases by 
the specified % Value. 

Volume 
Alert 

• Alerts you when security volume gains the specified Value. 

Margin 
Equity 
Warning 

• Alerts you when the trade price decreases to 3.05. At 
$3.00, marginability increases to 100%. 

Day Alert • Alerts you when the Change from Open either Increases to 
or Decreases to the specified Values. 

 

SETTING ALERT TEMPLATES 

1. You can either create a new template from scratch or go to the Account 
Detail window Alerts tab and select Alerts > Templates from the menu.  
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2. To set up a template from scratch, in Alert Templates click Add to open the 
following Add Template window: 
 
 

 
3. Alternatively select one of the Sample templates that is similar to your 

strategy, and select Edit to rename it and modify its parameters. 

4. Set up the fields in the template the way you would an alert, except for the 
fields you want to fill in at the time the order is placed, such as the Symbol. 

5. Click OK when you’re finished and it will save to the list of Alert Templates. 
All new templates must be named or they cannot be used or saved.  

To apply a template to a position: 

1. Right-click on an open position in the Account Detail window or go to Alerts 
> Templates and select Apply Alert to [symbol].  

2. A sub-menu will open and you will be able to choose from the templates 
listed there. 

3. The symbol will pre-fill based on the position you selected and the template 
window will pop up with only the blank fields highlighted for you to fill in 
before the alert is set.  

! NOTE:  Unless you wish to set-up templates for specific positions, the symbol 
and the value fields are left blank until you set the specific alert. If your alert 
template includes a conditional order, the shares and price fields can also be left 
blank and entered when you set the alert. 
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In this example, Value is the variable in the template to be filled in when you’re 
ready to set the Alert. 

 

To set up the template as a persistent alert: 

Check Keep alert active after logoff at the top of the template window, then fill 
in the rest of the blue fields and click OK to activate the alert. 

To Apply an Alert Template to an Alert or Conditional Order For a Security 
You Do Not Own: 

1. Set up your template the same way you would a regular alert, leaving the 
Symbol and Value fields blank.  

2. In the Account Detail, click Alerts > Templates in the menu bar. If the 
Menu Bar is not visible, right-click in the window and select Show Menu.  

3. Click on the template for the alert you set up.  

4. Click Complete or double-click the Alert Template name.  

5. The template set-up window will appear and prompt you to complete the 
remaining fields.  

6. Click OK.  

7. Verify your conditional order and confirm that you have read the Alerts 
Warning, if applicable, and the Alert set will appear in the Alerts and 
Conditional Order Entry window. 

 TIP:   Remove Saved Templates 
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• You can remove Templates by highlighting the Template you want to 
remove and either click Remove or right-click to Remove. 

• You can also edit an existing template to meet your changing needs. 

 

ALERT VARIABLE DESCRIPTIONS 

Alert Variable Descriptions 

The following tables describe various alerts that you can create, as well as how the 
alert will trigger. 

• Trade P&L Alerts 

• Share P&L Alerts 

• Bid Alerts 

• Ask Alerts 

• Volume Alerts 

• Trade Price Alerts 

• Change From Open Alerts 

• Change From Close Alerts 

• Additional P&L Alert Scenarios 

 

Trade Profit & Loss Alerts 

Scenario:  
• You bought 1000 shares of stock at 30. The current Bid is 31 and the current 

Ask is 32.  

• Based upon the Original Trade Price of 30 that you enter, the software has 
calculated your current unrealized gain (Trade P&L) as $1,000 (1000 shares 
X (31-30)). 

Level of 
Complexity 

Variable Criteria Value 
(Points, 
Shares, 

$, or 
%) 

Is Trailing 
Stop 

Available? 

Conditions that 
cause the alert 

to fire 

Advanced Trade 
P&L 

Increases 
to 

$2000 No Alert will fire if 
the Bid rises to 
32 or more. At 
that time, your 
Trade P&L 
equals or 
exceeds $2000 
(1000 shares X 2 
(Bid price of 32 
minus your 
original Trade 
Price of 30)). 
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Advanced Trade 
P&L 

Decreases 
to 

-$2000 No Alert will fire if 
the Bid drops to 
28 or less. At 
that time, your 
Trade P&L 
equals or 
exceeds -$2000 
(1000 shares X –
2 (your original 
Trade Price of 30 
minus the Bid 
price of 28)). If 
you had entered 
this as +$2000, 
the alert would 
fire 
automatically, 
because the 
current Trade 
P&L of $1000 is 
already less than 
$2000. 

Advanced Trade 
P&L 

Gains $2000 Yes Alert will fire if 
the Bid rises to 
33 or more. At 
that time, your 
Trade P&L has 
increased $2000 
(2 points X 1000 
shares). 

Advanced Trade 
P&L 

Loses $2000 Yes Alert will fire if 
the Bid drops to 
29 or less. At 
that time, your 
Trade P&L has 
dropped from 
+1000 to -1000 
(1000 shares X -
2 (Bid price of 
31 at the time 
that you entered 
the alert minus 
the new Bid 
price of 29)).  

Advanced Trade 
P&L 

Gains 20% Yes Alert will fire if 
the Bid rises to 
31.20 or more. 
At that time, 
your Trade P&L 
has risen 20% 
from its value at 
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the time that 
you created the 
alert (Trade P&L 
of $1000 plus 
20%). 

Advanced Trade 
P&L 

Loses 20% Yes Alert will fire if 
the Bid drops to 
30.80 or less. At 
that time, your 
Trade P&L has 
decreased 20% 
from its value at 
the time that 
you created the 
alert (Trade P&L 
of $1000 less 
20%). 

 

Share P&L Alerts 

Scenario:  
• You bought 1000 shares of stock at 30. The current Bid is 31 and the current 

Ask is 32.  

• Based upon the Original Trade Price of 30 that you enter, the software has 
calculated your current unrealized gain (Share P&L) as $1 per share (31-30). 

Level of 
Complexity 

Variable Criteria Value 
(Points, 
Shares, 

$, or 
%) 

Is Trailing 
Stop 

Available? 

Conditions that 
cause the alert 

to fire 

Advanced Share 
P&L 

Increases 
to 

2 No Alert will fire if 
the Bid rises to 
32 or more. At 
that time, your 
Share P&L 
equals or 
exceeds 2 points 
(Bid price of 32 
minus your 
original Trade 
Price of 30).  

Advanced Share 
P&L 

Decreases 
to 

-2 No Alert will fire if 
the Bid drops to 
28 or less. At 
that time, your 
Share P&L 
equals or 
exceeds -2 
points (original 
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Trade Price of 30 
minus the Bid 
price of 28). If 
you had entered 
this as positive 2 
points, the alert 
would have fired 
automatically 
fire, because the 
current Share 
P&L of 1 point is 
already less than 
2 points. 

*Advanced Share 
P&L 

Gains 2 Yes Alert will fire if 
the Bid rises to 
33 or more. At 
that time, your 
Share P&L has 
increased 2 
points from the 
value that 
existed at the 
time that you 
created the 
alert. 

*Advanced Share 
P&L 

Loses 2 Yes Alert will fire if 
the Bid drops to 
29 or less. At 
that time, your 
Share P&L has 
dropped 2 points 
from +1 point to 
–1 point.  

*Advanced Share 
P&L 

Gains 20% Yes Alert will fire if 
the Bid rises to 
31.20 or more. 
At that time, 
your Share P&L 
has risen 20% 
from its value at 
the time that 
you created the 
alert (Original 
Share P&L of +1 
plus 20%).  

*Advanced Share 
P&L 

Loses 20% Yes Alert will fire if 
the Bid drops to 
30.80 or less. At 
that time, your 
Share P&L has 
decreased 20% 
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from its value at 
the time that 
you created the 
alert (Share P&L 
of 1 point less 
20%). 

*Note that Share P&L initializes each day based on the Market Open Price, rather 
than on your original trade price. This means that if you are using a Variable of 
Share P&L and a Criteria of Gains or Loses and the stock opens significantly higher 
or lower than the price at which you purchased the stock, the initialization value 
could be applied further from the original trade price than you might wish. 

 

Bid Alerts 

Scenario: You bought 1000 shares of stock at 30. The current Bid is 31 and the 
current Ask is 32. 

 

Level of 
Complexity 

Variable Criteria Value 
(Points, 
Shares, 

$, or 
%) 

Is Trailing 
Stop 

Available? 

Conditions 
that cause the 

alert to fire 

Basic Bid Increases 
to 

33 No Alert will fire if 
the Bid rises to 
33 or more. 

Basic Bid Decreases 
to 

29 No Alert will fire if 
the current Bid 
falls to 29 or 
less. 

Intermediate Bid Gains 2 Yes Alert will fire if 
the Bid rises to 
33 or more. The 
alert reference 
point is based 
on the current 
Bid of 33 (31 
plus 2 points). 

Intermediate 

 

Bid Loses 2 Yes Alert will fire if 
the Bid falls to 
29 or less. The 
alert reference 
point is based 
on the current 
Bid of 31 minus 
2 points. 

Intermediate 

 

Bid Gains 20% Yes Alert will fire if 
the Bid rises to 
37.20 or more. 
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The alert 
reference point 
is based on the 
current Bid of 
31 plus 6.20 
(20% of 31). 

Intermediate 

 

Bid Loses 20% Yes Alert will fire if 
the Bid falls to 
24.80 or less. 
The alert 
reference point 
is based on the 
current Bid of 
31 minus 6.20 
(20% of 31). 

 

Ask Alerts 

Scenario: You bought 1000 shares of stock at 30. The current Bid is 31 and the 
current Ask is 32. 

 

Level of 
Complexity 

Variable Criteria Value 
(Points, 
Shares, 

$, or 
%) 

Is Trailing 
Stop 

Available? 

Conditions 
that cause the 

alert to fire 

Basic Ask Increases 
to 

33 No Alert will fire if 
the Ask rises to 
33 or more. 

Basic Ask Decreases 
to 

29 No Alert will fire if 
the Ask falls to 
29 or less. 

Intermediate Ask Gains 2 Yes Alert will fire if 
the Ask rises to 
34 or more. The 
alert reference 
point is based 
on the current 
Ask of 32 plus 2 
points. 

Intermediate 

 

Ask Loses 2 Yes Alert will fire if 
the Ask falls to 
30 or less. The 
alert reference 
point is based 
on the current 
Ask of 32 minus 
2 points. 
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Intermediate 

 

Ask Gains 20% Yes Alert will fire if 
the Ask rises to 
38.40 or more. 
The alert 
reference point 
is based on the 
current Ask of 
32 plus 6.40 
(20% of 32.) 

Intermediate 

 

Ask Loses 20% Yes Alert will fire if 
the Ask falls to 
25.60 or less. 
The alert 
reference point 
is based on the 
current Ask of 
32 minus 6.40 
(20% of 32). 

 

Volume Alerts 

No scenario is required to understand Volume Alerts. 

 

Level of 
Complexity 

Variable Criteria Value 
(Points, 
Shares, 
$, or %) 

Is Trailing 
Stop 

Available? 

Conditions 
that cause 
the alert to 

fire 

Basic Volume Increases 
to 

1,000,000 No Alert will fire if 
Volume equals 
or exceeds 
1,000,000 
shares. 

Basic Volume Decreases 
to 

1,000,000 No Although you 
can create this 
alert, it will 
never fire, 
because 
Volume never 
decreases 
during the 
market 
session. 

Intermediate Volume Gains 1,000,000 Yes, but 
serves no 
purpose 

Alert will fire if 
1,000,000 
additional 
shares are 
traded than 
the existing 
Volume at the 
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moment the 
alert was 
established. 

Intermediate 

 

Volume Loses 1,000,000 Yes, but 
serves no 
purpose 

Although you 
can create this 
alert, it will 
never fire, 
because 
Volume never 
decreases 
during the 
market 
session. 

 

Trade Price Alerts 

Scenario: You bought 1000 shares of stock at 30. The current Bid is 31 and the 
current Ask is 32. Last Trade Price was 31. 

 

Level of 
Complexity 

Variable Criteria Value 
(Points, 
Shares, 

$, or 
%) 

Is Trailing 
Stop 

Available? 

Conditions 
that cause the 

alert to fire 

Basic Trade 
Price 

Increases 
to 

33 No Alert will fire if 
the last Trade 
Price rises to 33 
or more. 

Basic Trade 
Price 

Decreases 
to 

30 No Alert will fire if 
the last Trade 
Price declines to 
30 or less. 

Intermediate Trade 
Price 

Gains 2 Yes Alert will fire if 
the last Trade 
Price rises 2 
points to 33. 

Intermediate 

 

Trade 
Price 

Loses 2 Yes Alert will fire if 
the last Trade 
Price loses 2 
points to 29. 

Intermediate 

 

Trade 
Price 

Gains 20% Yes Alert will fire if 
the last Trade 
Price gains 20% 
to 37.20 (31 
plus 6.20 (20% 
of 31)) or more. 

Intermediate Trade Loses 20% Yes Alert will fire if 
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 Price the last Trade 
Price loses 20% 
to 24.80 (31 
minus 6.20 
(20% of 31)) or 
less. 

 

Change From Open Alerts 

Scenario: Opening price for equity "XYZ" is $15. Current Trade Price is $16 and 
current Change from Open is +$1. 

 

Level of 
Complexity 

Variable Criteria Value 
(Points, 
Shares, 

$, or 
%) 

Is Trailing 
Stop 

Available? 

Conditions 
that cause the 

alert to fire 

Basic Change 
from 
Open 

Increases 
to 

2 No Alert will fire if 
the Change 
from Open is +2 
or more. In this 
case, Trade 
Price for XYZ 
must be 17 (15 
plus 2) or more. 

Basic Change 
from 
Open 

Decreases 
to 

-2 No Alert will fire if 
the Change 
from Open is –2 
or less. In this 
case the Trade 
Price for XYZ 
must be 13 (15 
minus 2) or 
less. 

Intermediate Change 
from 
Open 

Gains 2 Yes Alert will fire if 
the Change 
from Open 
increases to +3 
or more (current 
Change from 
Open of +1 plus 
2). In this case, 
Trade Price for 
XYZ must 
increase to 18 
(16 plus 2) or 
more.  

Intermediate 

 

Change 
from 

Loses 2 Yes Alert will fire if 
the Change 
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Open from Open 
decreases to –1 
or less. In this 
case, Trade 
Price for XYZ 
must decrease 
to 14 (16 minus 
2) or less. 

Advanced 

 

Change 
from 
Open 

Gains 20% Yes Alert will fire if 
the Change 
from Open 
increases to 
+1.20 (current 
Change from 
Open of 1 plus 
20% of 1) or 
more. In this 
case, Trade 
Price for XYZ 
must be 16.20 
(16 plus 0.20) 
or more. 

Advanced 

 

Change 
from 
Open 

Loses 20% Yes Alert will fire if 
the change from 
the Change 
from Open 
decreases to 
+0.80 (current 
Change from 
Open of +1 
minus 20% of 
1) or less. In 
this case, Trade 
Price for XYZ 
must be 15.80 
(16 minus 0.20) 
or less.  

 

Change From Close Alerts 

Scenario: Closing price for equity "ABC" is $35. Current Trade Price is $36 and 
current Change from Close is $1. 

 

Level of 
Complexity 

Variable Criteria Value 
(Points, 
Shares, 

$, or 
%) 

Is Trailing 
Stop 

Available? 

Conditions 
that cause the 

alert to fire 

Basic Change 
from 

Increases 
to 

2 No Alert will fire if 
the Change 
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Close from Close is +2 
or more. In this 
case, Trade 
Price for ABC 
must be 37 (35 
plus 2) or more. 

Basic Change 
from 
Close 

Decreases 
to 

-2 No Alert will fire if 
the Change 
from Close is –2 
or less. In this 
case the Trade 
Price for ABC 
must be 33 (35 
minus 2) or 
less. 

Intermediate Change 
from 
Close 

Gains 2 Yes Alert will fire if 
the Change 
from Close 
increases to +3 
or more (current 
Change from 
Close of +1 plus 
2). In this case, 
Trade Price for 
ABC must 
increase to 38 
(36 plus 2) or 
more.  

Intermediate 

 

Change 
from 
Close 

Loses 2 Yes Alert will fire if 
the Change 
from Close 
decreases to –1 
or less. In this 
case, Trade 
Price for ABC 
must decrease 
to 34 (36 minus 
2) or less. 

Advanced 

 

Change 
from 
Close 

Gains 20% Yes Alert will fire if 
the Change 
from Close 
increases to 
+1.20 (current 
Change from 
Close of +1 plus 
20% of 1) or 
more. In this 
case, Trade 
Price for ABC 
must be 36.20 
(36 plus 0.20) 
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or more. 

Advanced 

 

Change 
from 
Close 

Loses 20% Yes Alert will fire if 
the Change 
from Close 
decreases to 
+0.80 (current 
Change from 
Open of 1 minus 
20% of 1) or 
less. In this 
case, Trade 
Price for ABC 
must be 35.80 
(36 minus 0.20) 
or less. 

 

Additional P&L Alert Scenarios* 

Scenario 1:  

You bought 1000 shares of XYZ at 20. Bid is 21.   

Your current unrealized profit (Trade P&L) is +$1000. Depending on your objective, 
you could set up the alert in different ways: 

   
If your objective is...  

• A bigger profit of $2000, then enter "Trade P&L" "Increases to" "$2000", 
Original Trade Price = "20", and "beep".  
- Trigger: If XYZ trades at or above 22.00, then the application will beep.  

• To protect a profit of $500, then enter, if "Trade P&L" "Decreases to" "$500", 
Original Trade Price = "20", and "beep".  
- Trigger: If XYZ trades at or below 20.50, then the application will beep.  

• To limit your loss to -$500, then enter, if "Trade P&L" "Decreases to" "-
$500", Original Trade Price = "20", and "beep".   
- Trigger: If XYZ trades at or below 19.50, then the application will beep.  

Scenario 2:  

You bought 1000 shares of XYZ at 20. Bid is 19.   

Your current unrealized loss (Trade P&L) is -$1000. Depending on your objective, 
you could set up the alert in different ways: 

   
If your objective is...  

• To limit your loss to -$2,000, then enter if "Trade P&L" "Decreases to" "-
$2000", Original Trade Price = "20", and "beep".  
-Trigger: When XYZ trades at or below 18.00, then the application will beep.  
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• To decrease your loss to -$500, then enter if "Trade P&L" "Increases to" "-
$500", Original Trade Price = "20", and "beep".  
-Trigger: When XYZ trades at or above 19.50, then the application will beep.  

• A gain of $500, then enter, if "Trade P&L" "Increases to" "$500", Original 
Trade Price = "20", and "beep".  
-Trigger: When XYZ trades at or above 20.50, then the application will beep.  

* Both Share P&L and Trade P&L logic functions the same way. 

 

ALERT SCENARIOS 

Alert Scenarios 

The following four topics present different scenarios and show you different ways 
that you can accomplish the same goal. You will notice that you can accomplish the 
same thing with a Basic Alert as you can with an Advanced Alert. 

 

Scenario 1: Gain 

Scenario 2: Preserving a Gain 

Scenario 3: Loss 

Scenario 4: Minimizing a Loss 

 

Scenario 1: Gain 

You bought 1000 shares of XYZ at 45.  

• Current Bid=50.   

• Share P&L is +5 (50-45).  

• Current Ask=55.   

• Last Trade=50.   

• Open=49. Change from Open=+1.  

• Previous Close=48. Change from Close=+2.  

Goal: You already have an unrealized profit of $5 per share (11.11% of original 
cost) and you want to enter an order to sell when you have a profit of $10 per 
share (22.22% of original cost) on XYZ.  

 

Variables Increases 
to $ 

Decreases 
to $ 

Gains 
$ 

Gains % Loses 
$ 

Loses 
% 

Trade 
P&L 

10,000 N/A 5,000 100% 
(Gains 
$/Trade P&L) 

N/A N/A 

Share 
P&L 

10 N/A 5 100% 
(Gains 
$/Share P&L) 

N/A N/A 

Bid 55 N/A 5 10% 
(Gains $/Bid) 

N/A N/A 
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Ask N/A N/A N/A N/A N/A N/A 

Volume N/A N/A N/A N/A N/A N/A 

Trade 
Price** 

55 N/A 5 10% 
(Gains $/Bid) 

N/A N/A 

Change 
from 
Open** 

6 N/A 5 500% 
(Gains $/Chg 
from Open) 

N/A N/A 

Change 
from 
Close** 

7 N/A 5 250% 
(Gains $/Chg 
from Close) 

N/A N/A 

 

**Alerts using "Trade Price", "Change from Open" and "Change from Close" are 
triggered based upon Last Trade. Last Trade can be based upon either Bid or Ask, 
so be careful when setting up these types of alerts. 

 

Scenario 2: Preserving a Gain 

You bought 1000 shares of XYZ at 45.  

• Current Bid=55.   

• Share P&L is +10 (55-45).  

• Current Ask=60.   

• Last Trade=55.   

• Open=52. Change from Open=+3.  

• Previous Close=51. Change from Close=+4.  

Goal: You have an unrealized profit of $10,000 (22.22% of original cost) and you 
want to enter an order to sell if your profit decreases to $5000 (11.11% of original 
cost).  

 

Variables Increases 
to $ 

Decreases 
to $ 

Gains 
$ 

Gains 
% 

Loses 
$ 

Loses % 

Trade 
P&L 

NR $5,000 N/A N/A 5,000 50% (Loses 
$/Trade P&L 

Share 
P&L 

NR 5 N/A N/A 5 50% (Loses 
$/Share P&L) 

Bid NR 50 N/A N/A 5 9.09% (Loses 
$/Bid) 

Ask N/A N/A N/A N/A N/A N/A 

Volume N/A N/A N/A N/A N/A N/A 

Trade 
Price** 

NR 50 N/A N/A 5 9.09% (Loses 
$/Bid) 

Change 
from 

NR -2 N/A N/A 5 167% (Loses 
$/Chg from 
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Open** Open) 

Change 
from 
Close** 

NR -1 N/A N/A 5 125% (Loses 
$/Chg from 
Close) 

 

**Alerts using "Trade Price", "Change from Open" and "Change from Close" are 
triggered based upon Last Trade. Last Trade can be based upon either Bid or Ask, 
so be careful when setting up these types of alerts. 

 

Scenario 3: Loss 

You bought 1000 shares of XYZ at 55.  

• Current Bid=50.   

• Share P&L is –5 (50-55).  

• Current Ask=55.   

• Last Trade=50.  

• Open=49. Change from Open=+1.  

• Previous Close=48. Change from Close=+2.  

Goal: You have an unrealized loss of $5 per share (-9.09% of original cost) and 
you want to enter an order to sell if your loss increases to $10 per share (-18.18% 
of original cost).   

 

Variables Increases 
to $ 

Decreases 
to $ 

Gains 
$ 

Gains 
% 

Loses 
$ 

Loses % 

Trade 
P&L 

N/A -10,000 N/A N/A 5,000 100% (Loses 
$/Trade P&L 

Share 
P&L 

N/A -10 N/A N/A 5 100% (Loses 
$/Share P&L) 

Bid N/A 45 N/A N/A 5 10% (Loses 
$/Bid) 

Ask N/A N/A N/A N/A N/A N/A 

Volume N/A N/A N/A N/A N/A N/A 

Trade 
Price** 

N/A 45 N/A N/A 5 10% (Loses 
$/Bid) 

Change 
from 
Open** 

N/A -4 N/A N/A 5 500% (Loses 
$/Chg from 
Open) 

Change 
from 
Close** 

N/A -3 N/A N/A 5 250% (Loses 
$/Chg from 
Close) 

**Alerts using "Trade Price", "Change from Open" and "Change from Close" are 
triggered based upon Last Trade. Last Trade can be based upon either Bid or Ask, 
so be careful when setting up these types of alerts. 
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Scenario 4: Minimizing a Loss 

You bought 1000 shares of XYZ at 60.  

• Current Bid=50.   

• Share P&L is -10 (50-60).  

• Current Ask=55.   

• Last Trade=50.   

• Open=51. Change from Open=-1.  

• Previous Close=52. Change from Close=-2.  

Goal: You have an unrealized loss of $10,000 (-16.67% of original cost) and you 
want to enter an order to sell if your loss is only $5000 (-8.33% of original cost).  

 

Variables Increases 
to $ 

Decreases 
to $ 

Gains 
$ 

Gains % Loses 
$ 

Loses 
% 

Trade 
P&L 

-5,000 N/A 5,000 50% 
(Gains 
$/Trade P&L) 

N/A N/A 

Share 
P&L 

-5 N/A 5 50% 
(Gains 
$/Share P&L) 

N/A N/A 

Bid 55 N/A 5 10%  
(Gains $/Bid) 

N/A N/A 

Ask N/A N/A N/A N/A N/A N/A 

Volume N/A N/A N/A N/A N/A N/A 

Trade 
Price** 

55 N/A 5 50% 
(Gains $/Bid) 

N/A N/A 

Change 
from 
Open** 

4 N/A 5 500% 

(Gains $/Chg 
from Open) 

N/A N/A 

Change 
from 
Close** 

3 N/A 5 250% 
(Gains $/Chg 
from Close) 

N/A N/A 

**Alerts using "Trade Price", "Change from Open" and "Change from Close" are 
triggered based upon Last Trade. Last Trade can be based upon either Bid or Ask, 
so be careful when setting up these types of alerts. 
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Balances 

BALANCES TAB 

The Balances tab gives you vital account information, including updated Day Trade 
Buying Power for certain accounts, margin buying power on margin accounts, and 
bank balances for Bank Sweep IRA accounts. If your accounts are in a margin call, 
the amount will be shown on the last line of the Balances screen.  

All balances are automatically updated every fifteen minutes or 30 seconds after 
your orders are executed, whichever happens first. The Balances tab on margin 
accounts includes a Margin Buying Power figure. Click on the Details button to get 
more details about your Margin Buying Power.  

Balances Tab For a Margin Account with Day Trading Buying Power: 

 

Balances Tab for a Cash account: 
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! NOTE:  You must be in Live mode to see balances on the Balances tab. When 
you are in Demo mode, balances will not display.  

 

Tab Columns Descriptions 

Total 
Account 
Value 

The Total Account Value is the sum of your securities, unswept 
or intra-day cash, money market funds, bank deposit accounts, 
and net credit or debit balances in your account.  

Today's 
Change 

Indicates the change in account value from the previous trading 
day's close. This includes your trading activity, as well as 
deposits and withdrawals.  

Available to 
Trade (Using 
cash) 

The maximum amount of money in your account that you can 
use to trade without accessing margin borrowing.  

Available to 
Trade (Cash 
+ 
Borrowing) 

Also known as "Margin Buying Power", this is the amount of 
money you can use to trade marginable equities using cash and 
the margin feature of your account. View Buying Power Details 
to understand this value for all security types. This value is only 
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shown in accounts with a margin feature. You will be charged 
interest on any amount you borrow that exceeds the Available 
Cash in the account.  

Details 
Button 

Click on this button to open up the Buying Power Details 
window, which displays the maximum amount of any given 
security type that you can purchase using margin borrowing. 
This value is only shown in accounts with a margin feature  

Available to 
Withdraw 
(Using cash) 

The maximum amount of money you can withdraw without 
accessing margin borrowing. The amount is a combination of 
credits in the account less any cash on hold.  

Available to 
Withdraw 
(Cash + 
Borrowing) 

The maximum amount you can withdraw from your account to 
by requesting a check or transferring funds to another account. 
This value includes the cash balance in your account, plus the 
maximum amount you can borrow against marginable 
securities held in your margin account. Note that recent 
deposits earn interest and are available for most types of 
trading activity, but are not reflected in your authorization limit 
until they are cleared. This value is only shown in accounts with 
a margin feature. You will be charged interest on any amount 
you borrow that exceeds the Available Cash in the account.  

Settled Cash 
Available to 
Trade 

Trading in the Margin Account 

Trading on margin does not require settled funds. If 100% of 
the trading activity occurs on margin, there will be no 
difference between the settled funds to trade balance and the 
total available to trade balance. Traders that fit this profile will 
not be affected by the special requirements that may result 
from Cash Account trading activity.  

Traders that occasionally trade non-marginable securities in the 
Cash Account should continue reading.  

Settled funds are:  

• incoming cash (such as a deposit or wire)  

• available Margin Loan Value  

• settled sale proceeds of fully paid for securities.  

Settled funds may be used for purchases of securities. If a 
security is purchased using settled funds, there are no 
requirements surrounding the timeframe of when the newly 
purchased securities can be sold.  

However, if unsettled funds are used to purchase securities and 
the customer sells the securities prior to making full payment, 
these newly purchased securities may be subject to special 
requirements. Securities purchased using unsettled funds, 
should not be sold prior to the settlement of the funds used to 
purchase these securities (generally 3 business days after the 
sale of the security which generated the funds).  

If these securities are sold prior to settlement of the financing 
sale then additional funds will be required to be deposited in 
the account to cover the cost of the newly purchased securities. 
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If no additional funds are deposited within 5 business days of 
the purchase, the sale of these securities will constitute a "free 
ride" under Federal Reserve Regulation T. This will result in a 
90-day settled cash-up-front restriction.  

EXAMPLE  If you sold a fully paid for security on Monday the 
1st, you could use the proceeds to purchase new a security 
prior to the settlement day of Thursday the 4th (3 day 
settlement). However, if you sold the newly purchased security 
prior to the settlement date (Thursday the 4th), you would then 
be required to deposit funds to pay for the purchase.  

If you sold the new position on Thursday the 4th, or anytime 
there after, no additional funds would be required. 

Cash 
Secured Put 
Assignment 

Displays the Cash Secured Requirement, 100% of assignment 
value of the put position, when a Cash Secured Equity Put is in 
the account. 

This balance will only display if you have placed a cash secured 
equity put and will be located below the Settled Cash available 
to trade balance. 

Cash & Money Market 

Trading in the Cash Account 

Settled funds are:  
• incoming cash (such as a deposit or wire)  

• settled sale proceeds of fully paid for securities.  

Settled funds may be used for purchases of securities. If a security is purchased 
using settled funds, there are no requirements surrounding the timeframe of 
when the newly purchased securities can be sold.  

However, if unsettled funds are used to purchase securities and the customer 
sells the securities prior to making full payment, these newly purchased 
securities may be subject to special requirements. Securities purchased using 
unsettled funds, should not be sold prior to the settlement of the funds used to 
purchase these securities (generally 3 business days after the sale of the 
security which generated the funds).  

If these securities are sold prior to settlement of the financing sale then 
additional funds will be required to be deposited in the account to cover the cost 
of the newly purchased securities. If no additional funds are deposited within 5 
business days of the purchase, the sale of these securities will constitute a "free 
ride" under Federal Reserve Regulation T. This will result in a 90-day settled 
cash-up-front restriction.  

EXAMPLE  If you sold a fully paid for security on Monday the 1st, you could use 
the proceeds to purchase new a security prior to the settlement day of Thursday 
the 4th (3 day settlement). However, if you sold the newly purchased security 
prior to the settlement date (Thursday the 4th), you would then be required to 
deposit funds to pay for the purchase. If you sold the new position on Thursday 
the 4th, or anytime there after, no additional funds would be required.  

Cash This represents the total dollar value of your unswept or intra-
day cash, money market funds, bank deposit accounts, and net 
credit or debit balances you hold in the Schwab account you 
have selected to view.  
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Money 
Market 
Funds 

The value of the cash you have invested in the money market 
sweep fund(s) you selected for your account. (For Schwab 
Investment Accounts, interest is earned on any credit balances 
in the account and is not reflected in the Money Market Fund 
balance).  

Bank Deposit 
Accounts 

Schwab acts as your agent and custodian in establishing and 
maintaining your Bank Deposit Accounts. Bank Deposit 
Accounts constitute direct obligations of the Sweep Bank (as 
defined below) and are not an obligation of Schwab. Free Credit 
Balances will be deposited into Bank Deposit Accounts without 
limit even if the amount in the Bank Deposit Accounts exceeds 
the $100,000 FDIC insurance limits. For deposit insurance 
purposes, deposits you may establish in one capacity directly 
with a Sweep Bank or through an intermediary, such as 
Schwab, will be aggregated with the Bank Deposit Accounts. 
You are responsible for monitoring the total amount of deposits 
you have with the Sweep Bank in order to determine the extent 
of deposit insurance coverage available to you. Sweep Bank 
means the Schwab-affiliated, FDIC-insured bank, as referenced 
in your account statements and disclosed in your account 
documents into which free credit balances may be 
automatically deposited pursuant to your Account Agreement.  

Margin 
Balance 

The balance of any credits or debits in your margin account. 
Note that with a margin account, the balance of unsettled 
debits or credits for trades will show here until settlement. You 
do not start paying interest until trades are settled. 

Short 
Balance 

The net Open balance in your account arising from short sale 
transactions.  

Total Cash The net Cash balance in your Schwab account.  

Securities:  This displays the value of securities you hold long and short in your 
account.  

Note: Marginable securities are always held in your margin account; 
non-marginable securities are always held in your non-margin 
account.  

Cash Account & Margin Account 

Market Value 
Long 

The total marked-to-market value of your long positions 
(broken out by marginable and non-marginable securities) 
based on the last trade price. If for some technical reason real-
time valuations are not available, the values displayed may be 
based on the prices from the close of the previous business day 
or on twenty-minute-delayed quotes.  

Market Value 
Short 

The total marked-to-market value of your short positions 
(broken out by marginable and non-marginable securities) 
based on the last trade price. Such positions will typically be 
shown in the margin account column.  

Options:  This displays the value of options you hold long and short in your 
account.  

Note: Your options are typically held in the margin portion of your 
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account. Option information only displays for accounts that hold option 
positions.  

Market Value The total value of your long and short options positions based 
on their current, real-time market prices. Options are not 
marginable securities but are normally shown in the margin 
account column for accounting purposes.  

Total 
Securities 

The total values of all long and short securities positions, 
including options, in the margin and cash accounts. A combined 
net value for the margin and cash accounts is also provided.  

Margin/Equity Requirements 

Margin 
Equity 

The dollar value of marginable securities in your margin 
account, less the amount you owe Schwab, plus any cash in 
your margin account. This is the liquidation value of your 
margin account, but does not include option positions, 
segregated money market funds, or cash not held in the 
margin account. Margin Equity represents the total amount you 
invested in securities plus any excess cash, minus funds 
borrowed on margin.  

Equity 
Percent 

Your margin equity divided by the market value of your margin 
account. This amount reflects the percentage of the current 
margin account value you would receive if you liquidated the 
margined securities, paid off any margin debt and withdrew the 
funds. Options, cash account positions and segregated money 
market funds are not included when calculating the equity 
percentage.  

Day Trade 
Buying 
Power 

This field will only be displayed if we identify you as a pattern 
day trader (there are rules governing this designation).  For 
information about Day Trading Buying Power (DTBP), please 
consult your Schwab Active Trader Broker.  

Month to 
Date Int. 
Owed 

The amount of margin interest you owe Schwab, accrued from 
the beginning of the interest period through the date of your 
inquiry. The interest period begins on the second to last day of 
each month.  

Margin Call If your margin equity falls below the percentage level required 
under Schwab or regulatory requirements; if you make a 
purchase for which you have insufficient equity to meet the 
Fed's requirements; or if you have insufficient cash to cover 
your open, uncovered option or spread positions, you will be 
subject to a margin call. If there is a margin call on your 
account, it may be displayed at the bottom of the screen and 
immediate action on your part is required. However, Schwab 
reserves the right to initiate immediate liquidation procedures 
without notice.  
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 TIP:  Showing/Hiding the Balance Status Bar 

To hide your Net Worth or any other Balance Status Bar field from being 
displayed on your screen, simply click on the label Net Worth next to the 
numerical field.  The Net Worth field will disappear.  

 

BALANCES BAR 

The Balances Bar keeps important account data at your fingertips. You 
may customize the types of data shown based on the information that's 
most important to you.  

To enable, click Toolbar > Balances Bar in the main menu.  

To customize, right-click in the Balances Bar and select Customize. 

 

 

 TIP:  Hide individual stats in your Balances Bar by clicking on the name. 
Today's Change is hidden in the image below.  

 

Select the statistics to display by clicking on Toolbars > Customize > Balances 
Bar in the main menu or by right-clicking on the Balances Bar and selecting 
Customize... The following settings window opens: 

 
• Click on an item in the Available Column to view a description of it, then click 

Add to select the item for display in the Balances Bar.  

• Change the order in which the fields are displayed in your Balances Bar by 
clicking on the field in the Selected Fields column and then click Move Up or 
Move Down. 
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• To minimize the screen space used by the labels, click Use Abbreviated 
Field Labels. 

 TIP:  Change any of the fields on the fly by right-clicking on the name of the 
field and selecting a different one from the drop-down list.  

 
 

BALANCES BAR FIELDS 

Avail to 
Trade - Cash 

The maximum amount of money in your account that you can 
use to trade without accessing margin borrowing. 

Day Trade 
BP 

Total market value of new securities into which you may enter 
and subsequently exit without incurring a margin call. 

Margin 
Equity 

The dollar value of marginable securities in your margin 
account, less the amount you owe Schwab, plus any cash in 
your margin account. This is the liquidation value of your 
margin account, but does not include option positions, 
segregated money market funds, or cash not held in the 
margin account. Margin Equity represents the total amount you 
invested in securities plus any excess cash, minus funds 
borrowed on margin. 

Equity Pct Your margin equity divided by the market value of your margin 
account. This amount reflects the percentage of the current 
margin account value you would receive if you liquidated the 
margined securities, paid off any margin debt and withdrew the 
funds. Options, cash account positions and segregated money 
market funds are not included when calculating the equity 
percentage. 

Today's % 
Change 

The percent change in value of the account since today's 
market open, whether due to security price movements, 
securities transactions, any other withdrawals and deposits, or 
credits and debits. 

Today's 
Change 

The change in value in dollars of the account since today's 
market open, whether due to security price movements, 
securities transactions, any other withdrawals and deposits, or 
credits and debits. 

Acct. Net 
Worth 

The 'liquidation value' of your account (excluding fees, 
commissions, pending interest credits and debits, etc.), which 
is the combined value of all your cash, money market funds, 
margin balances, securities and any miscellaneous 
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debits/credits in your account. 

Cash The total dollar value of your unswept or intra-day cash, money 
market funds, bank deposit accounts, and net credit or debit 
balances. 

Margin BP The maximum value of marginable securities in which you can 
invest without depositing more equity in your margin account; 
this includes funds you can borrow from Schwab, but does not 
include balances in your Cash Account or Money Market Funds. 

Avail to 
Withdraw 

The maximum amount you can withdraw from your account by 
requesting a check or transferring funds to another account. 
This value includes the cash balance in your account, plus the 
maximum amount you can borrow against marginable 
securities held in your margin account. 

Settled Cash 
to Trade 

Trading in a Cash account requires using Settled funds. If a 
security is purchased using settled funds, there are no 
requirements surrounding the time frame of when the newly 
purchased securities can be sold. Settled funds are comprised 
of: incoming cash (such as a deposit or wire transfer), any 
available Margin Loan Value, or settled proceeds from the sale 
of securities that have been fully paid. 
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Positions 

POSITIONS TAB 

The Positions tab displays all open positions for a given account. The positions are 
displayed with real-time quotes - regardless of which Schwab venue you used to 
enter or exit the position.  

The Market Value is calculated based on the number of shares and the current 
price. The Price is the current last trade price (streaming). The Change value is the 
Change from Close. If you prefer to view the Change from Open go to Settings > 
General. 

 

 
 

 TIPS:   

Open Positions Window 

The Open Positions window (View > Positions) in the Account Detail window 
allows you to execute the same functions as right-clicking on a position in the 
Positions tab of the Account Detail window. With a the stand-alone Open 
Positions window visible in your layout, you never have to tab back and forth 
between Order Status and Positions to see your Positions. 

The Open Positions window can be set to graphically display data. To change 
the display from Text to Graphical:  

1. Open the Open Positions window by going to Account Detail and 
selecting View > Positions.  

2. When the pop-up window opens, select Settings > General.  

3. When the following pop-up box opens, select Graphical. 
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The Open Positions window will display the gain or loss of your positions in a 
horizontal bar chart.  

Auto Sorting 

If Auto Sorting is checked, any changes to information in the Positions window 
will be sorted into the existing information according to the current sort order. 

For example, if you have your Positions Tab sorted by P&L, as the price 
changes for symbols in your window, the list will automatically adjust its sort 
order to accommodate those changes.  

 

Each position in your account is displayed in this window, including those in money 
market funds. You can sort the table by clicking on any column heading. A second 
click will reverse the sort order.  

 

Tab Columns Descriptions 

Symbol The unique 1-5 characters used to represent the security. 
Symbols are defined by the different markets or exchanges. 
Sometimes a security might not have a symbol, in which case, 
an internal Schwab reference # will be used.  

Name The full name of the security. 

Quantity For stocks or mutual funds, this field reflects the number of 
shares you currently hold. For fixed income securities, this field 
reflects the face value of the securities. For options, this field 
reflects the number of option contracts. 

Price The price at which the security last traded. 

Market Value This figure reflects the current value of your position, normally 
calculated using real-time quotes, where possible. This value is 
updated as the quote changes. 

Cost The total price paid for the position the position,. An asterisk 
next to this value indicates that the amount displayed is in 
most cases not correct. Usually this is due to incomplete data 
on record for the position. If all or part of the position was 
purchased before January 2004 then you will see an asterisk. 
Also note that the cost figure provided is the sum of all fills and 
does not include commissions or other fees. To correct this 
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value use either the drop down or right click menu and select 
Adjust Cost. You may enter the total amount paid or received 
for the position using this function. Once this has been done 
the asterisk will disappear even though future fills will not 
include commissions and therefore may not be absolutely 
accurate. You may adjust the cost as often as you like. 

+/- (Profit 
or Loss in 
Dollars) 

Displays the unrealized profit or loss on the position in dollar 
format. P&L is calculated based on an average price paid per 
share.  

! NOTE:  Lot accounting is not used, so P&L is NOT calculated 
on a LIFO/FIFO basis. (See example in P&L Calculations topic.) 
There are limitations on the reporting of transactions/events 
that make up the P&L amounts.  

+/-% (Profit 
or Loss as a 
percentage) 

Displays the unrealized profit or loss on the position as a 
percentage. P&L is calculated based on an average price paid 
per share.  

! NOTE: Lot accounting is not used, so P&L is NOT calculated 
on a LIFO/FIFO basis. (See example in P&L Calculations topic.) 
There are limitations on the reporting of transactions/events 
that make up the P&L amounts. 

DRI This stands for Dividend Reinvestment Instructions. Certain 
stocks and mutual funds pay a dividend. These dividends may 
be reinvested into additional shares of the security, or can be 
paid to you in cash, depending upon your instructions. "Yes" 
indicates that the corresponding security's dividend is being 
reinvested. "No" indicates that no dividends are being 
reinvested for that security and that dividends will be paid in 
cash.  

Type Describes what type of security the position is. 

 

Right-click 
Options 

Descriptions 

Load 
[Symbol] 
into Trading 
Window  

• Loads the symbol into the Trading window.  

• The quantity field is set to the Trading window default 
size - may not match your position size. Go to Settings 
> General to change the default quantity to Set 
Quantity to Open Position.  

Recent 
Stories for 
[Symbol]  

Loads the symbol into the News window.  

Adjust Cost 
for [Symbol] 

Allows you to add and edit cost information for your position.  

Research/Ext 
Quote for 
[Symbol]  

Launches a web browser that automatically opens at 
schwab.com for quotes and research. 
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Apply Alert 
to [symbol]  

Opens sub-menu allowing you to use an alert template or 
create a new alert. 

Close 
[Symbol] 

Closes out the position and sends a SmartEx order. 

Show/Hide 
Menu 

Shows/removes the Account Detail menu.  

 

P&L CALCULATIONS 

Following is an example of how P&L is calculated when there are multiple 
executions for one position: 

 

Executions Average Cost Per 
Share 

What the Positions 
Tab Displays 

1/15/04Buy 500 DELL @ 
20 

20 

Calculation: 

(500 * 20) = 10000 --> 
20 per share 

1/15/04 500 DELL Cost 
$10,000 

1/15/04Buy 500 DELL @ 
30 

25 

Calculation:  

(500 * 30) = 15000 --> 
(2500 / 1000) --> 25 per 
share  

1/15/04 1000 DELL Cost 
$25,000 

1/16/04Sell 200 DELL @ 
35 

25  

(note that the sell price 
is irrelevant) 

1/16/04 800 DELL Cost 
$20,000 

(25 x 800 = 20,000) 

1/16/04Sell 400 DELL @ 
32 

25 1/16/04 400 DELL Cost 
$10,000 

(25 x 400 = 10,000) 

1/17/04Buy 600 DELL @ 
32 

29.20 

Calculation: 

[(1000 - 200 - 400) * 
25] = 10000 

(600 * 32) = 19200 --> 
(29200 / 1000)  

--> 29.20 per share  

1/17/04 1000 DELL Cost 
$29,200 

(29.20 x 1000 = 29,200) 

1/17/04Sell 600 DELL @ 
34 

29.20 1/17/04 400 DELL Cost 
$11,680 

(29.20 x 400 = 11, 680) 
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Important Information Regarding P&L Calculations for your Accounts 

An asterisk (*) indicates a position with cost data that may be incomplete because 
it does not include transactions that occurred prior to August 2004. The cost and 
profit and loss data may also be incomplete because it excludes commissions, 
transaction fees, and corporate actions such as stock splits, stock dividends, spin-
offs, mergers, and name changes. To correct the cost data, select the position and 
use the right-click menu to select the “Adjust Cost” function. Please note that the 
Account Detail tool is not the official record of your account. Your statements and 
confirmations are the official records of your account. 
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Transactions 

TRANSACTIONS TAB 

The Transactions tab displays transactions for the current day, as well as 
transactions made within the last 90 days.  The Transactions view page is read-
only, so the data can not be manipulated, but can be exported for use with other 
programs such as MS Excel.  

You can view:  
• Trade executions  

• Deposits  

• Withdrawals  

• Trade Away and Prime Broker transactions  

• Transfers between your brokerage and a bank deposit account  

! NOTE: Transaction History information is not available in Demo mode. 

To View Your Transaction History:  

1. Go to the Account Detail window and click on the Transactions tab.  

2. Click Transactions > Update in the menu. 

3. Enter the number of days you want to view transactions for, up to 90 days.  

4. Click OK. 
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! NOTE: If your account includes transfers made to or received from a bank 
deposit account, the footnote shown in the image above will display. 

 

Tab Columns Descriptions 

Date The date the transaction occurred. For trade orders this reflects 
the date the order was filled.  

Action This indicates whether a action was a Buy, Sell, Sell Short, or is 
left blank for monetary transactions.  

Quantity • The number of stock or mutual fund shares bought, sold 
or sold short.  

• For fixed income securities, this number reflects the face 
value of the security you bought or sold.  

• For options, this reflects the number of option contracts 
you bought or sold.  

• For monetary transactions, this field will display a zero.  

Symbol The 1-5 letter abbreviation used to represent the security. For 
monetary transactions, this field will display a zero. 

Description This field provides a description of the security or an 
explanation of the transaction.  

Price This indicates the price you paid or received for the purchase or 
sale of a unit of the security. For example, if you bought 10 
shares of ABC at $90 a share, the price would be $90. For 
monetary transactions, this field will display $0.00. 

Amount This indicates the total amount of the transaction. Numbers 
inside ( ) indicate money was deducted from your account. 
Numbers without the brackets mean money was deposited into 
your account.  

Commission Displays the commission paid for a specific transaction. If no 
commission applied or if the trade was executed today, you will 
see an asterisk (*). 
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ABOUT THE USER MANUAL 

This Educational Guide and its content (including price and volume data, screen 
samples, and queries) are for informational and educational purposes only. 
Although it may provide general information relating to trading or investment 
approaches, you should not construe anything in the guide as legal, tax, and 
investment, financial or other advice. Nothing contained in the guide constitutes a 
solicitation, recommendation, promotion, endorsement, or offer by Schwab of any 
particular security, transaction, or investment strategy. 

Schwab makes no recommendations or endorsements with respect to any of the 
strategies, chart patterns, or indicators referenced; nor does Schwab recommend 
the use of technical analysis as a sole means of investment research. 

At Schwab, we recommend that investors define their goals, risk tolerance, time 
horizon, and investment objectives in addition to researching possible investment 
choices through multiple channels. Use of technical analysis may result in increased 
frequency of trading and, therefore, significantly higher transaction costs than a 
fundamental approach. 

CyberTrader, an affiliate of Charles Schwab & Co., Inc., provides technical services 
for StreetSmart Pro, a Schwab product. StreetSmart Pro is a registered trademark 
of Charles Schwab & Co., Inc. Schwab StreetSmart Pro is a pending trademark of 
Charles Schwab & Co., Inc. 

Access to Electronic Services and your account may be limited or unavailable during 
periods of peak demand, market volatility, systems upgrades or maintenance, or 
for other reasons. 
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Agreements 

Your Agreements With Schwab & Other Useful Information 

• CyberTrader®, an affiliate of Charles Schwab & Co., Inc., provides technical 
services for StreetSmart Pro®, a Schwab product.  

• Charles Schwab & Co., Inc. (member SIPC) and CyberTrader, Inc. (member 
SIPC/NASD) are independent subsidiaries of The Charles Schwab 
Corporation.  

• StreetSmart Pro® is offered at no charge to a select group of non-
professional Schwab Active Trader* clients who meet certain eligibility 
requirements based on trading frequency. This offer may be subject to 
additional restrictions and may be changed at any time.  

• The speed and performance of streaming functionality may vary depending 
on your modem speed, ISP connection and the number of securities you 
maintain on your Watch Lists. You need a Pentium 266 MHz or better 
processor, 128 MB RAM or more and a 56k or better modem, DSL or cable 
modem to receive the best possible experience of streaming quotes and 
news on StreetSmart Pro.  

• Using AOL with Windows 98 to download StreetSmart Pro could cause 
potential problems in the download process.  

StreetSmart Pro provides advanced market information for your desktop and allows 
you to place orders. It also allows you to connect and place trades through 
schwab.com. This User Manual explains how to use StreetSmart Pro’s trading 
capabilities and provides instructions on how StreetSmart Pro can be used with 
schwab.com. This manual is designed to give you easy-to-use, step-by-step 
instructions for using StreetSmart Pro.  

• Access to Level II data requires meeting certain eligibility requirements 
based on trading frequency. For additional information, please contact your 
Schwab Active Trader Team.  

• The market data used in this manual is for illustrative and educational 
purposes only, and is not intended to reflect actual trading behavior or other 
characteristics of any securities or company.  

• This manual was developed for use with StreetSmart Pro and should not be 
used for other trading software or channels.  

• You will receive an announcement about updates to the StreetSmart Pro 
software and User Manual the first time you Log Off StreetSmart Pro after 
the enhancements and upgrades become available. You may also receive 
updates through other methods, including electronic notification or emails.  

• Please remember that the real-time market data available through 
StreetSmart Pro may come from different sources than the real-time market 
data sources for Velocity, schwab.com, or other Schwab websites. This may 
result in slight differences in quotes and other information, especially in fast-
moving markets.  

Your use of each version of StreetSmart Pro is governed by your 
agreements with Schwab, including: 
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• The End User License Agreement for StreetSmart Pro software that you must 
agree to as part of the software download process  

• Your account agreements, including the Electronic Services Agreement  

• Any disclosures associated with the market data and trade order routing and 
functionality incorporated in or related to the use of the software, including 
the Direct Access Disclosure and Agreement 

The following information is not intended to replace your careful review 
and acceptance of the agreements and disclosures outlined above: 

• Before using StreetSmart Pro, you should carefully read all disclosures and 
instructions that Schwab provides for a complete understanding of 
StreetSmart Pro’s capabilities.  

• If you have a question about the StreetSmart Pro software that cannot be 
answered by the Help file or User Manual, contact your Schwab Active Trader 
Broker before taking any action.  

• Since StreetSmart Pro depends on third-party data feeds, lines, and systems, 
the accuracy and timeliness of market data cannot be guaranteed.  

• If data feeds, servers, and communication lines fail, Schwab is not 
responsible for these third-party components.  

• Alert your Schwab Active Trader Broker about any problems you encounter in 
using StreetSmart Pro, so we can help resolve them.  

• Schwab will continue to upgrade the StreetSmart Pro software and User 
Manual periodically. It is your responsibility to stay up-to-date with the most 
recent versions by downloading upgrades and enhancements when notified 
by Schwab.  

• In using this software, you are acknowledging that you understand and 
accept the risks involved in online trading.  

• By making StreetSmart Pro available to you, Schwab is not recommending, 
promoting or endorsing any particular investment, market data, or trading 
strategies.  
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Link to Customer Education 

Click on the Education Weblink icon  in the toolbar to access all of Schwab's 
educational material including: 

• Using StreetSmart Pro®  

• Market Education  

• Direct Access Trading  

• Printable User Manuals  

• Trader's Education On-Line Courses  

• Introduction to Stock Screener  
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CSUK and Hong Kong Customers 

Eligibility for and Use of StreetSmart Pro® Software and Other Related 
Products  

• CyberTrader®, an affiliate of Charles Schwab & Co., Inc., provides technical 
services for StreetSmart Pro, a Schwab product.  

• Charles Schwab & Co., Inc. (member SIPC) and CyberTrader, Inc. (member 
SIPC/NASD) are independent subsidiaries of The Charles Schwab 
Corporation.  

• StreetSmart Pro is offered at no charge to a select group of non-professional 
Charles Schwab Hong Kong and customers referred by Charles Schwab UK 
who meet certain eligibility requirements based on trading frequency. This 
offer may be subject to additional restrictions and may be changed at any 
time.  

• To learn more about specific eligibility standards for use of StreetSmart Pro 
by customers of Charles Schwab Hong Kong and customers referred by 
Charles Schwab UK, please contact your customer service representative.  

• For customers in Asia, UK, and Switzerland accessing StreetSmart Pro via 
DSL, ISDN or cable modem is strongly recommended in order to receive 
optimal speed and performance of streaming market data functionality  

• Certain products and services described in this Online Help guide may not be 
available to customers of Charles Schwab Hong Kong and customers referred 
by Charles Schwab UK, including but not limited to:  

o Access to schwab.com  

o Velocity Trading software  

o Schwab Platinum service and Schwab Platinum representatives  

o Direct Access trading via StreetSmart Pro  

o E-Mail Alerts and Trade Confirmations  

Your use of each version of StreetSmart Pro is governed by your 
agreements with Schwab, including:  

• The “End User License Agreement” and “StreetSmart Pro Disclosure and 
Agreement” that you must agree to as part of the software download process  

• Your account agreements, including the “Electronic Services Agreement”  

• Any disclosures associated with the market data and trade order routing and 
functionality incorporated in or related to the use of the software  

• Any laws or regulations in force in your country of residence pertaining to the 
download and use of encrypted software.  
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